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Important Note: Data formats have changed in version 6 of MotiveWave.  Workspaces created 

using older versions of MotiveWave will be forward compatible (ie they can be used in Version 

6) but once the workspace has been opened in version 6, it will not be able to be opened by older 

versions.  Please consider creating a new workspace for version 6 testing and restore from a 

backup of an existing workspace. 

 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Zoom Bar Width – Adjustments to the bar width smaller 1 pixel wide will automatically 

adjust the bar size (linear bars only).  For example, if the bar size is 1 minute, reducing 

the bar width (from 1 pixel) will switch the bar size to 2 min, 4 min, 8 min etc.  

Expanding the bar width from that state will revert the bar size to 4 min, 2 min and then 1 

minute. 

2. OHLC Developing Mid/High/Low – Options have been added to show the developing 

Midpoint, High and Low values. 

3. DOM- The following options have been added to the DOM: 

a. Show Order Brackets – Before an order is placed from the DOM, the cells in the 

Order column will display where the entry and exit orders will be placed along 

with their quantities.  You can turn this feature off in the DOM Preferences (see 

General panel, “Show Order Brackets”) 

b. Highlight Price Row – The entire row can now be highlighted for the last price 

(see Price Column tab in the DOM Preferences dialog). 

4. Exit Strategy Orders – Placeholder orders will now be displayed for the exit orders that 

will be generated when an entry order is filled. 

5. Volume Imprint Trade Dots – The Volume Imprint study has been enhanced to show 

large trades at the Bid/Ask on the left/right sides of the Imprint (see Trade Dots tab). 

6. Cloud Levels “Edit Mode” – The Cloud Levels study now has an edit mode (right click 

on the study header and choose “Edit Mode”).  This will allow you to edit the price 

levels and add/delete levels.  The changes can be saved to a CSV file via Right Click -> 

Save option 

7. VWAP Component – (Order Flow, Professional and Ultimate Editions only).  The 

VWAP component is available as a Mouse Tool or in the “General” tab of the 

Components Panel.  This behaves similar to the VWAP study, but has resize points to 

choose the Start/End points. 

8. Order Heatmap – Added an option to filter the maximum sizes.  This will filter out 

large sizes that can skew the heatmap colors. 

9. SDK – Additional methods added to the Study class to provide more interaction with the 

mouse: 

a. onDoubleClick() – Allows the study to respond to double click events 

b. onClick() – Respond to single click events 

c. onWheelMoved() – Respond to mouse wheel events. 

https://www.motivewave.com/download.htm


Version 6.4.7 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Profit/Loss Components – Added right click options to Flip, and change the number of 

targets. 

2. Time&Sales 

a. @Bid/@Ask Background – Added an option to set the background (in addition 

to text color) 

b. Highlight Big Sizes – Added an option to highlight the size cell only 

c. Price Format – Added options for displaying only part of the price 

d. Time Format – Added options for formatting the time column 

3. Shift Wheel Action – Added an option to change the behavior of holding down the shift 

key when using the mouse wheel.  By default this will adjust the vertical spacing. 

Version 6.4.6 

This is a bug fix only release.  No new features are included in this update. 

Version 6.4.5 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Order Heatmap – Added an option to scale visible rows only.  This will apply the color 

map to the sizes that are visible only. 

2. DOM Templates – Added the ability to import and export DOM templates 

3. DOM / Time & Sales /Order Book - Holding down the CTRL (CMD on Mac) key 

while scrolling the mouse wheel will change the row height of the table.  This will allow 

you to zoom in/out. 

4. DOM Recenter – Double click on the DOM table will recenter.  Holding down the 

control key will recenter all DOMs  

5. Cumulative Delta – Added options to change the color above/below 0 for a line chart 

(see advanced properties, Color Policy option) 

6. Zig Zag – Added option for reversal in ticks. 

 

Version 6.4.4 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Cross Trading – Cross trading futures contracts can be done via right click on the chart 

and choose: Cross Trade (symbol).  For example, you can trade the MES contract from 

an ES chart. 

2. Stacked Orders  

a. DOM – Orders at the same price will be displayed with brackets [].  The quantity 

displayed will be the sum of all the orders.  The position in queue marker will 

also display multiple markers.   

b. Price Graph – Orders that overlap will be offset to show that multiple exist and 

you can click drag any of the orders. 

3. Drag Stacked Orders – Holding on the control key (command on Mac) while dragging 

an order in the DOM or price graph will modify all orders of the same type and price.   



4. Rithmic – Support for delayed accounts 

5. Java 16 – Updated to the latest version of Java/JavaFX 

 

Version 6.4.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. DOM Panel   

a. Price Column – Added Alignment and option to display cumulative trades (same 

as Last Trade Quantity Column) 

b. Table Striping – Added option to turn off the striping of the table rows 

2. Time/Sales and Order Book – Added option to turn off striping of the table rows 

3. Erase Chart Shortcut – Added Erase option to the mouse shortcuts for the chart.  This 

shortcut would allow you to use a keyboard modifier to erase chart elements with a 

mouse click. 

4. Fractal Study – Added a “Show Label” option to display the price of the high/low 

 

Version 6.4.2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. DOM Panel   

a. Orders 

i. Right Click – Added access to order combinations (Limit + Stop/Limit 

etc) via a right click menu on the DOM Table 

ii. Configurable Mouse Orders – The behavior of placing orders directly on 

the DOM table may now be configured to place order combinations.  

Additionally, keyboard modifiers (Shift, Ctrl, Ctrl+Shift) may be used to 

setup multiple order types/combinations.  (See DOM Preferences, 

General tab) 

b. LTQ Column – this column can be configured to highlight the background of the 

cell when the trade occurred at the bid or ask. 

c. Table Font – The font used for the table cells is now configurable from the DOM 

Preferences dialog. 

d. Row Height – A fixed row height can be set for the table 

2. Time and Sales Panel 

a. Table Font – The font used for the table cells is now configurable from the 

Time/Sales Preferences Dialog 

b. Row Height – A fixed row height can be set for the table 

c. Min Width – The minimum width of this panel has been reduced to 175 px. 

3. Order Book Panel 

a. Table Font – The font used for the table cells is now configurable from the 

Time/Sales Preferences Dialog 

b. Row Height – A fixed row height can be set for the table 

4. Ruler Tool – Added an option to make the Ruler stick to the chart after its drawn.  This 

effectively adds it as a component to the chart.  See Preferences Dialog (Configure -> 

Preferences from the Console Menu bar), Chart -> Options tab.  Erase Ruler option. 



5. Hide Account Name – The account name can be obfuscated in all the MotiveWave 

screens and display as “XXXXXX857” (for example).  See Preferences Dialog -> 

General Panel. 

6. VWAP – Multiple VWAP studies using the same criteria can now be added to the chart 

with different anchor points.  Note: they must have different colored/styled lines. 

Version 6.4.1 

This is a bug fix only release.  No new features are included in this update. 

Version 6.4.0 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Chart Indicators – The following enhancements have been added to the Chart 

Indicators: 

a. Chart Specific Settings – Charts can override the global settings from the Chart 

Preferences Dialog (double click on the chart, see “Indicators” tab). 

b. Avg Entry Price – This new indicator displays the average entry price for the 

current position as an indicator. 

c. Tags – optionally a tag may be assigned to an indicator.  This tag displays the 

given text to the left of the indicator. 

2. Time Axis – The following enhancements have been added to the Time Axis: 

a. Chart Specific Settings – Charts can override the global settings from the Chart 

Preferences Dialog (double click on the chart, see “Time Axis” tab). 

b. Line Color – a color can now be chosen for each time axis line that is enabled 

c. Time of Day – custom lines can be displayed at specific times of the day (ie: 

11:00 AM). 

3. Trading Hours – The following enhancements have been added to the Trading Hours 

feature (see General Preferences Dialog, General -> Trading Hours tab): 

a. Hours – the interface for specifying trading hours has been simplified to provide 

the same daily hours across multiple days (ie Monday – Friday, Sunday – 

Saturday etc) 

b. Edit Built-In Hours – The built-in hours can now be modified instead of creating 

a new set of trading hours.  You can revert to the default hours by selecting the 

modified hours in the list and pressing the “Delete” key. 

c. Multiple Exchanges – You can assign trading hours to multiple exchange. 

d. Intraday Bar – You can specify a bar build method for intraday bars (overriding 

the global default).  See Intraday Bars tab in the Trading Hours dialog. 

4. Default Layout – The default layout has changed when creating a new workspace. 

5. Watch List Notes – A “Notes” column has been added to the Watch Lists where you can 

enter custom notes.  Clicking on the cell in the watch list will allow you to edit the value 

inline. 

6. Popout Panels – A popout option has been more of the panels in the console: Accounts, 

Positions, Orders, Trades, Optimizer, Alerts, Trade Report, Options, Journal. 

7. Sim Trade Only – An option has been added to the built-in simulated account to only 

allow trading on the internal sim account.  See Preferences Dialog (Configure -> 

Preferences from the Console menu bar.  Click on “General” and then on “Simulated 



Account”). 

8. Intraday Bar Build – The method for configuring how intraday bars are built can not be 

set per instrument or per Trading Hours (see above). 

9. Miscellaneous Features 

a. Export Trades – now includes milliseconds 

b. Alerts – Comments are now displayed in the alerts and alert history panels 

c. OHLC Study – Added previous open 

d. Labelled Line – Price can be chosen in the properties dialog 

e. Study Graph – Ability to remove the display of the study title (see Options tab 

“Show Legend”) 

f. Exit Strategy – Added decimal places for stop/target where the offset type is 

“Percent” 

g. Quick Search – Auto complete feature can be turned off 

h. Volume Imprint – Horizontal offset can be added to the Summary Profile 

i. TPO Study – Volume profiles now have an option align (left or right) 

j. Mid Point – Added midpoint column to watch lists.  This is the midpoint 

between the bid/ask prices 

Version 6.3.4 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. TDA – Order Book has an added option to expand the rows by Market Maker and 

optionally color rows at the same price 

2. Time Calculation Method – Added an option to calculate elapsed time in a component 

using Elapsed time vs Trading time.  This option is available in the Preferences dialog 

(Configure -> Preferences from the top menu bar, see Chart -> Chart Settings) 

3. Time Sales – Added an optional end time field.  This allows to you scroll to a specific 

time in the Time and Sales panel.  (See Time and Sales Preferences Dialog).  

 

Version 6.3.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Interactive Brokers Smart Depth – Order Book has an added option to expand the rows 

by Market Maker and optionally color rows at the same price 

Version 6.3.2 

 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Interactive Brokers Smart Depth – Upgraded to the latest TWS API and added support 

for SMART depth for stocks 

2. CQG – Updated to the latest CQG API 

3. Cumulative Delta – Added the ability to restart delta calculation at start of week or start 

of month. 

4. Trade History – Added the option to choose account on Export to CSV feature. 

5. DOM shortcuts – Added the ability to assign keyboard shortcuts to the following 

actions: 



a. Reset @Bid/@Ask 

b. Lock DOM 

c. Clear Notes 

6. DOM Price Scaling – The scaling of the price ladder in the DOM can now be synced 

with the price graph. A new button has been added to the tool bar in the DOM to toggle 

this feature on /off.  

7. LTQ DOM Column – Added a column to the DOM for computing last traded quantity. 

Version 6.3.1 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Study Quick Editor/Tool Bar – Study controls can now be added to the tool bar and are 

accessible from a new Quick Editor on the chart. 

a. Quick Editor – buttons have been added to the study titles to show a Quick 

Editor that contains study controls 

b. Tool Bar – A “Tool Bar” tab has been added to the study dialog to choose 

controls that are displayed in the tool bar. 

c. Tool Bar Study Editor – A “Study Editor” action is available to add to the tool 

bar.  This is used in conjunction with the Tool Bar option above and will display 

the selected controls.  (See Preferences Dialog, “Tool Bar” tab). 

2. SDK – The SDK has been enhanced to specific settings that are available to the Quick 

Editor and tool bar.  For details see the updated SDK document: 

https://www.motivewave.com/support/sdk.htm 

 

Version 6.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Rithmic 10.16 – Updated to the latest Rithmic library.  This update includes significant 

updates to the performance of loading historical tick data. 

2. Order Heatmap – This new study replaces the existing DOM History study.  This has 

the following changes: 

a. Gradient Color Control - a single color control that allows you to select multiple 

colors to use as a gradient for categorizing the relative totals of orders in the 

DOM at each price.   

b. Contrast – This option allows you to hide levels that have totals below a specific 

percentage of the highest value 

c. Opacity – Changes the opacity of all the bands 

d. Lines – optionally displays divider lines between the banks 

3. Big Trades – Added an “Auto Circle” option to adjust the size of the circle based on the 

trade size.  Larger trades will appear with a larger circle. 

4. Millisecond Bars – Bar sizes can now be specified in milliseconds (min 20 ms) 

5. Auto Move Bar – If enabled, this option will automatically create the next bar when the 

time has elapsed (instead of waiting for the next bar).  This is especially useful for 

Millisecond bars (see above) to show a continuously moving chart (See Preferences 

Dialog, Configure -> Preferences from the Console menu bar.  Click on “Chart” then on 

“Options”) 



6. Line Chart Label – Allows you to change the label displayed to the right of a line chart.  

Options are: None, Price and Symbol.  This is available from the Chart Settings dialog 

(right click on the chart and choose “Chart Settings”). 

7. Trade Report – Generates a report (similar to the report in the Optimizer) for an 

account.  This option also works for replay mode.  A Trade Report tab can be added by 

clicking on the ‘+’ button to the right of a chart tab. 

8. Zytrade – Added a new broker connection for Zytrade (Futures and Future options, 

connects via Rithmic). 

9. Java/JavaFX 15 – Updated to the latest Java and JavaFX 15.0.1 

10. Cloud Levels Study – Display price levels that can be loaded from a local file or from a 

website.  Supported formats include BookMap and IRT CSV files. 

11. Price Bar Types – Square line charts have been added.  These are similar to the line 

charts, but only draws horizontal and vertical lines (no diagonals): 

a. Square Line 

b. Square Line (Shaded) 

c. Square Line (Gradient) 

Version 6.2.5 

This is a bug fix only release.  No new features are included in this update. 

Version 6.2.4 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Futures Roll Options – Added support for additional roll options and added defaults 

for major futures contracts: 

a. Days Before Start of Contract Month 

b. Days Before Day of Week Before Contract Month 

c. Days Before Day of Month Before Contract Month 

d. Days Before 1st Business Day of Contract Month 

e. Days After Start of Contract Month 

f. Days Before Day of Week 

g. Days Before Day of Month 

h. Days Before End of Contract Month 

i. Days Before Last Business Day of Contract Month 

2. Active Contract – Added the ability to show the active contract for a Continuous 

Future in the Quote Board and Buy/Sell Boxes.  See Preferences Dialog (Configure 

-> Preferences from the Console menu bar.  Click on “Buy/Sell” tab). 

3. Trade Manager Strategy – Added the ability to specify Ticks or Pips when 

calculating offsets. 

Version 6.2.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Continuous Futures – Added support for custom continuous futures contracts that 

automatically roll based on volume or expiry date.  Choose File -> New -> 

Continuous Future from the Console menu bar. 

2. Active Contract – The active contract for a continuous future (see feature above) can 



be displayed in two locations: 

a. Chart Label – A new chart label has been created for this.  See Chart 

Settings -> Labels tab 

b. Watch List – a new Column “Active Contract” has been added to the Watch 

List/Quote Sheets. 

 

Version 6.2.2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Kraken – Added support for Kraken crypto exchange 

2. Coinbase Pro – Added support for Coinbase Pro exchange 

3. Binance – Added support for Cross Margin Accounts 

4. JavaFX 14.0.2.1 – Updated to the latest JavaFX version 

5. Questrade – Removed support for Questrade 

6. Rithmic – The following enhancements were added to the Rithmic connector 

a. Added the following environments: 

i. Rithmic 04 Colo 

ii. Rithmic 04 Aurora 

iii. Speedup 

b. Exchange Order ID – Added aggressor and resting exchange order ids to the 

live tick data. 

7. Time & Sales Panel – Added option to “Aggregate by Order” (using new Rithmic 

feature above).  If enabled time & sales entries will be combined if the aggressor 

exchange Order Ids and price match.  This applies to consecutive trades only. 

8. Big Trades – Added “Aggregate by Order” option (see above). 

9. OHLC Study – Added support for specifying seconds for the opening range 

 

Version 6.2.1 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Binance – Added support for Binance crypto exchange 

2. Quote Board – This is a new view for a Watch List/Quote Sheet (in addition to table 

and Buy/Sell boxes).  You can change a watch list to display a quote board by 

choosing “Quote Board” in the drop down in the watch list tool bar. 

3. Java 14.0.2 – Updated to the latest Java version 

Version 6.2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Community Edition – New Free Edition of MotiveWave 

2. CryptoCompare – Added support the latest web socket API.  Also added support 

for the Order Book (Level 2 data). 



Version 6.1.17 

This is a bug fix only release.  No new features are included in this update.  

Version 6.1.16 

This is a bug fix only release.  No new features are included in this update.  

Version 6.1.15 

This is a bug fix only release.  No new features are included in this update.  

Version 6.1.14 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Performance Improvements – Added some additional performance tweaks. 

2. Order Flow Edition – The Trade Edition has been renamed to the Order Flow 

Edition.  We also added the following features (previously only available in 

Professional and above): 

a. Volume Profile Component (see General Component tab) 

b. TPO Component (see General Component tab) 

3. Standard/Elliott Wave Lite Editions –Trading capability has been added to these 

editions, this includes the following: 

a. Live and Simulated Trading 

b. Account/Orders/Positions/Trade History Panels 

c. Trade Panel 

d. Time and Sales Panel 

e. Depth of Market – Note this is a basic DOM and does not include all of the 

features in the advanced DOM available in the Order Flow Edition and above 

f. Order Book Panel 

4. Show Roll Dates – Added options to show optional top and/or bottom markers for 

roll dates on the chart 

5. Instrument Graph Study -Added an option fixed range 

6. Java 14.01 -Updated to the latest Java version 

7. Rithmic - Updated to the latest Rithmic API (10.10.1.0). 

 

Version 6.1.13 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Performance Improvements – Some significant changes have been made to improve 

the performance of MotiveWave with high volumes of live market data. 

2. Watch List -Added an option to replace a futures contract with the next contract.  Right 

click on a futures contract in the Watch List/Quote Sheet and choose “Replace with Next 



Contract” 

3. Roll Date Lines – For continuous contracts computed on the client side, lines can be 

displayed for the roll dates in the chart.  See Preferences Dialog (Configure -> 

Preferences, click on “Chart” then on “Time Axis”).  The dates can be configured per 

chart from the Chart Preferences Dialog (double click on the chart, see “Display” tab). 

4. Trend Line – a different line style can be chosen for the extended parts of a trend line. 

See Properties dialog (double click on the trend line, “Format” tab). 

Version 6.1.12 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Chart Specific Data Settings – Continuous contract options can now be applied to a 

specific chart overriding instrument and global settings.  See Chart Preferences Dialog 

-> “Data” tab. 

2. Export Pages – For floating layouts, specific stations can be chosen to be included in the 

export. 

3. Compute Change Using Settlement – A new option has been added to compute the 

daily change information using the settlement price instead of the previous close (futures 

only).  This can be configured in the Preferences dialog (Configure -> Preferences see 

General tab). 

4. Rithmic – Added additional environments and also added an option on login to choose 

Aggregated vs Non-Aggregated data. 

5. Java 14 – Updated to Java 14 

Version 6.1.11 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Google/Yahoo Connection – Updated the connector to reflect recent changes for loading 

historical data from Yahoo 

2. Continuous Contracts –Added a new option to compute continuous contracts using the 

expiry date (instead of roll over on volume). 

Version 6.1.10 

This update contains an important fix for BarChart historical data. 

No new features are included in this update. 

Version 6.1.9 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. BarChart – Added support for Crypto Currencies 

2. New Studies: 

a. McClellan Oscillator – compares moving averages on the difference between 

advancing and declining issues. 

b. McClellan Summation Index – Displays a rolling summation of the McClellan 

Oscillator 

c. Seasonality – Calculates the average gain/loss (as a percentage) from the start of 

year or month. This study only works in daily bars. 



Version 6.1.8 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. BarChart Continuous Contracts – Optionally continuous data for futures contracts can 

be computed in MotiveWave (using the same logic as in CQG).  This will allow you to 

choose the back adjust method.  This feature can be enabled from the Preferences Dialog 

(Configure -> Preferences from the console menu bar.  See Historical Data -> General). 

Version 6.1.7 

This update contains important fixes for issues introduced in 6.1.6. 

Version 6.1.6 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. BarChart – Updated to the latest BarChart streaming connector 

2. Max Heap/JVM Options – added advanced options to the startup screen to adjust the 

Maximum Heap Size and additional JVM options.  (Choose: Options -> Advanced from 

the startup splash screen) 

3. Windows – Removed MotiveWave (3GB) and MotiveWave (6GB) launch options.  

Larger heap sizes can be set above. 

4. Auto Update – The Auto Update feature has been changed in this version to download 

the MotiveWave installer and execute it after closing MotiveWave.  This feature will 

also work on the Mac as well (instead of having to manually download and install). 

5. Linux – Support for Linux distributions (Debian Package Format): 

a. Ubuntu – 18.04, 19.10 

b. Mint – 19.3 

c. Kubuntu – 19.10 

Version 6.1.5 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Snap to Grid – Floating dock stations can be snapped to the grid when dragging the 

mouse.  This feature can be enabled/disabled in the Preferences dialog (Configure -> 

Preferences from the console menu bar.  See General > Dock) 

2. Elliott Wave – The following enhancements have been added to the Elliott Wave 

features (see Preferences Dialog: Elliott Wave > General tab) 

a. Label Inset – optionally, spacing can be added between the wave label and the 

top/bottom of the price bar.  

b. Draw Lines From Last Bar – If enabled wave lines will be drawn from the last 

(latest) price bar instead for the entire wave. 

3. Java Runtime – Updated Java runtime to 13.0.2 

4. Mac Install – Switch from a .dmg to a .pkg for the Mac installer 

5. Memory Gauge – A gauge has been added to the right side of the status bar (Console 

and Desktops) that displays the current memory usage of the application. 

6. IQFeed Filter NTRF – Added an option to filter trades from the NTRF exchange for 

stocks.  See Preferences Dialog > General Panel 



Version 6.1.4 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. CQG – The following changes have been done for CQG: 

a. Latest Protocol – Updated to the latest CQG Continuum Protocol 

b. Balances – Balances are now available in the Balances panel (click on the ‘+’ 

button next to a dock tab and choose “Balances”) 

2. Global Data Feeds – Updated the port number for the data server 

 

Version 6.1.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Bitstamp – Added support for Crypto Broker Bitstamp: https://www.bitstamp.net 

2. Order Book – Added an Order Book option.  This is similar to a DOM, but displays the 

Bid and Ask orders in separate tables (horizontally instead of vertically in a DOM) 

3. BarChart – Added “Use Continuous Data” option (See Instrument Dialog -> Advanced 

Tab).  This option is on by default for all new instruments and will display continuous 

historical data for futures. 

Version 6.1.2 

This is a bug fix only release.  No new features are included in this update.  

Version 6.1.1 

This is a bug fix only release.  No new features are included in this update.  

Version 6.1 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Untitled Analyses – By default, MotiveWave will open a new Untitled Analysis when a 

chart is opened.  The contents of this analysis is local to the chart and is not synched 

between other charts.  An untitled analysis can be saved as a regular analysis by clicking 

the Save As button.  For details on analyses in MotiveWave see: 

https://www.motivewave.com/guides/MotiveWave_Analyses.pdf 

2. New Studies- The following studies have been added in this update: 

a. Bressert DSS 

b. RMO (Rahul Mohinder Oscillator) 

c. MA Ribbon 

3. Export/Import Pages – This feature allows you to export specific pages from the 

Console or Desktops.  These pages can be imported to another instance of MotiveWave 

using the Import Page option (See File -> Import/Export Pages from the top menu bar).  

Pages can also be setup to export on a schedule.  See Preferences Dialog (Configure -> 

Preferences from the Console menu bar.  Click on “General” then “Backup” then “Auto 

Export Pages”) 

https://www.bitstamp.net/
https://www.motivewave.com/guides/MotiveWave_Analyses.pdf


4. Floating Grid Background – This option (on by default) shows a grid background on 

Floating layouts.  Configuration options can be found in the Preferences Dialog 

(Configure -> Preferences from the Console menu bar.  Click on “General” the on 

“Dock”). 

Version 6.0.8 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Labelled Line – This new component draws a horizontal line with a customizable label 

attached to it.  This component can be found in the “General” stencil (see Components 

Panel). 

2. Visibility Options – You can now add multiple visibility options to a component, study 

or wave/time ratio.  An object is visible when one of the visibility conditions is met. 

3. Alert Conditions – Multiple alert conditions are now allowed when creating/modifying 

an alert. 

4. Indicator “Draw on Top” – Added an option to draw an indicator on top of the other 

indicators.  This is on by default for Bid, Ask and Last price.  This feature is also 

available for study indicators (see advanced properties). 

Version 6.0.7 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. NT Renko Bars – This specialized version of Renko bars starts the next bar at the 

midpoint of the previous bar (instead of at the top/bottom of the previous bar).  This bar 

type was developed by Newbie-Trader: https://www.newbie-trader.com/ 

2. Elliott Wave Preferences – The following options have been added the Elliott Waves. 

See Preferences dialog “Elliott Wave” tab and the Component Properties dialog (double 

click on the wave): 

a. Show Origin – If unchecked, the origin point will not be shown (even if it is the 

top-level wave) 

b. No Future Points – If checked, none of the future points will be displayed.  This 

is in contrast to the Show Future Points being unchecked where only the first 

future point is displayed. 

3. Commentary Components – The text for comments can now be modified in the 

component properties dialogs (right click and choose “Properties” from the comment).  

Additionally, changing this text as part of a custom component/tool will change the 

default text when the component is created. 

Version 6.0.6 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Save As Image Name – A new chart option “Use Last Image Name” (default off) has 

been added to the Chart Options panel (Configure -> Preferences from the Console menu 

bar, Chart -> Options).  If this option is enabled the last Save As Image file name will 

be used the next time you save the chart as an image (instead of generating the file name 

with the lastest timestamp). 

2. Data Export – Historical data can now be exported automatically and arranged in 

groups.  For details, see the Preferences Dialog (Configure -> Preferences from the 

https://www.newbie-trader.com/


Console menu) Click on “Historical Data” then on “Data Export”.  For details see: 

https://support.motivewave.com/knowledge-base/data-export-groups/ 

 

Version 6.0.5 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Floating Stations – A new layout has been added to the docking framework to manage 

floating stations (instead of using the split layout).  For details see the Docking 

Framework guide: 

https://www.motivewave.com/guides/MotiveWave_Docking_Framework.pdf 

Version 6.0.4 

This is a bug fix only release.  No new features are included in this update.  

Version 6.0.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. TDA Login – The login procedure has been changed to use a browser-based login. 

2. DOM Bid Ask Scaling – Three additional options have been added for scaling the 

histogram for the bid/ask columns: 

a. Fixed Max Size – Sets the maximum size for the bid/ask columns to a fixed 

value. 

b. Max Scale Size – Sets an upper limit on the max bid/ask sizes. Use this to lessen 

the effects of unusually large bid/ask values 

c. Scale Visible Rows Only – If enabled the scaling will be based on the max values 

for the visible rows only (instead of all DOM rows) 

3. DOM Bid/Ask Column – Added an additional column that combines the bid/ask sizes 

into a single column 

4. DOM Orders Column - Added the following enhancements to the DOM Order Column: 

a. Auto Hide Cancel – The cancel button is only shown when the cursor hovers 

above the order 

b. Context Menu – The context menu (right click) shows pre-set quantities for 

quickly modifying the order quantity. 

Version 6.0.2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Java 13 – Updated to the latest Java VM.  This will require a full install on Windows 

(ie: download the latest installer from our website and run it on your local machine). 

https://support.motivewave.com/knowledge-base/data-export-groups/
https://www.motivewave.com/guides/MotiveWave_Docking_Framework.pdf


Version 6.0.1 

This is a bug fix only release.  No new features are included in this update.  

Version 6.0.0 

Version 6 has significant feature enhancements from version 5.  For a comprehensive 

explanation of all the changes please see: 

 

https://www.motivewave.com/guides/Whats_New_In_Version_6.pdf 

Version 6 Beta 3K 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Center All DOMs – This new option will center all Depth of Market panels when the 

re-center button is pressed (See DOM Preferences, General Panel).  For convenience a 

Keyboard Shortcut can also be assigned (see General Preferences Dialog, “General” -> 

“Keyboard” tab). 

2. IQFeed Odd Lot Ticks – This option will enable “Odd Lot Ticks” to be visible in 

MotiveWave for IQFeed symbols (off by default).  See General Preferences Dialog 

(Configure -> Preferences from the Console menu bar) -> “General” tab. 

Version 6 Beta 3J 

This is a bug fix only release.  No new features are included in this update.  

Version 6 Beta 3I 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Drag beyond available data – The chart can now be dragged beyond the available data 

leaving blank space on the left side of the chart. 

Version 6 Beta 3H 

This is a bug fix only release.  No new features are included in this update.  

Version 6 Beta 3G 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Updated Window Themes – The dark and light themes have been updated to remove 

station borders and present a flatter look and feel 

2. StockWatch Connector – This this data service connector has been removed in this 

update since they no longer support third party applications. 

3. TPO Study – The following enhancements have been added to the TPO study: 

a. Constrain Width – If this option is checked it will automatically reduce the cell 

https://www.motivewave.com/guides/Whats_New_In_Version_6.pdf


width if the profile overlaps the next profile. 

b. Align Letters per TPO – The align letters option may be enabled per TPO figure 

via the right click menu (right click on a TPO and choose “Align Letters”) 

c.  

4. Active Chart Tab Color – The color of the dock bar/tabs for active charts can be 

customized in the Preferences dialog (see “Theme” -> “Theme”, “Active Chart Tab 

Color) 

5. Time & Sales Text Color – The text color for the Time & Sales panel can now be 

configured from the TS Preferences dialog (click on the Gear icon) 

6. Cancel Existing Orders – An option has been added to cancel existing orders on the 

same account before executing a button action.  This applies to the following custom 

buttons in the Trade Panel/DOM: Break Even, Flatten and Reverse 

Version 6 Beta 3F 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Time Axis Spacing – Minimum spacing for major times displayed on the time axis has 

been added (default 100 pixels).  This option can be configured in the Preferences dialog 

(Configure -> Preferences from the console menu bar, click on Chart then on Time 

Axis). 

2. Extended vs Regular Bar Scheme – A new bar scheme has been added to color the 

extended and regular trading hours bars differently. 

3. VWAP Study – the following enhancements/changes have been added to the VWAP 

study: 

a. Std Dev Calculation – The calculation for the standard deviation has changed.  

It is now calculating using the difference between the HLC3 – VWAP (instead of 

the VWAP alone) 

b. Std Dev Bands – Up to 3 band lines can be configured  

c. Anchored VWAP – The starting point can be set for calculating the VWAP via 

right click (see menu options below): 

i. Remove Anchor – This option will remove a previously set anchor 

ii. Anchor VWAP at <Time> - This will set the anchor at the given time. 

4. Alert Close Position – An option has been added to close an open position when an alert 

is triggered (see Trade tab of the Alert Dialog). 

5. Study Indicator Tags – Descriptive tags can optionally be displayed next to the 

indicators displayed in the vertical axis.  Edit the advanced indicator settings (click on 

the edit button next to an indicator in the study dialog) and check the “Show Tag” box. 

Version 6 Beta 3E 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. TPO Study Align Letters – This option (see Display tab, Align Letters in Same 

Column check box) will place each letter in a separate column to better represent the 

time when that cell occurred. 

2. Reversal Bars – This new bar type has been added that has the following parameters: 

a. Reversal Amount – price movement in ticks from the high or low of the bar for 

the bar to complete.  The bar is considered complete when the close has reversed 



from the high/low by an amount equal or greater than this amount.  Reversal bars 

alternate between reversing from the high and low (ie if one bar reverses from the 

high, the next bar will reverse from the low) 

b. Minimum Amount – Minimum range for the bar (high – low) before the reversal 

amount is applied 

3. Relative Volume – This new study compares the volume on the current bar to the 

average volume for that same bar (same time of day) for the given period (see Study -> 

Volume -> Relative Volume). 

4. VWAP Study – Added top and bottom standard deviation lines (optional) 

5. EW Marker Tools – Added mouse tools for the Elliott Wave markers 

6. Move Copyright – The copyright message can be moved or hidden on specific chart via 

the right click menu: Move Copyright -> Location 

7. JPG image format removed – In the Save As Image dialog, the JPG image format has 

been removed since it is not supported by the Open JDK. 

8. Display Bars – The display bars setting can now be set individually for the chart.  See 

chart settings “General” tab. 

9. Bar Theme Price Line – The ability to change the price line for a custom bar theme has 

been added (when displaying a line chart vs a bar chart). 

10. Table Row Colors – The even and odd row colors for table elements can be customized 

from the Preferences Dialog (Configure -> Preferences from the console menu bar, click 

on Theme.  See option: Table Row Colors).  Note: a restart of MotiveWave is required 

to see the changed values. 

11. Time Axis Lines – Major vertical lines displayed from the time axis can be configured 

from the Preferences Dialog (Configure -> Preferences from the console menu bar.  

Click on “Chart” then on “Time Axis”).  The following lines may be configured 

a. Midnight – midnight using the time zone set for the chart. 

b. Start of Day ETH - Start of the day for extended trading hours (enabled by 

default). 

c. Start of Day RTH – Start of day for regular trading hours 

d. End of Day ETH – End of day for extended trading hours 

e. End of Day RTH – End of Day for regular trading hours 

f. Start of Week – Start of week (Sunday midnight) using the time for the chart 

g. Start of Month – Start of the month (midnight) using the time zone set for the 

chart (enabled by default). 

h. Start of Year – Start of the year (midnight Jan 1) using the time zone set for the 

chart (enabled by default). 

12. Copy Exit Strategy – A copy button has been added to the Exit Strategies Panel (See 

Trade Panel Preferences and DOM Preferences dialog). 

Version 6 Beta 3D 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Guide Templates – Templates have been added for price and time guides.  See 

properties dialog when creating or editing a guide.  Guides for a specific template can be 

added directly from the right click menu on the price or time axis. 

2. Scanner – Added the number of results in the “Scan Complete” message 

3. Center DOM Shortcut – Added a new keyboard short cut option “Center On Last Price” 



(default unassigned).  This will re-center the active DOM on the last price. 

4. Lock/Unlock Components – This action will toggle the locking of components on the 

active chart (instead of locking components individually).  (See View -> Lock/Unlock 

Components from the menu bar) 

5. NADAQ Hours – Modified extended hours from 7-20 EST to 4-20 EST 

6. SDK Aggregate & Filter Ticks – Two new options have been added to the Study 

Header (false by default).  If these options are enabled, the user will be able to configure 

the settings in the “Options” tab of the study dialog. 

a. allowTickAggregate – If true, the user will be given the option aggregate tick 

data using the given aggregate period in milliseconds 

b. allowTickFilter – If true, the user will be given the option to set a min and or 

max trade size to be filtered before passing the data to the study. 

c. Affected Studies – these options have been turned on for the following studies: 

Volume Imprint, Delta Volume, Cumulative Delta, Bid/Ask Volume 

7. Volume Imprint –  

a. Disable Column1 - Added option disable the display of Column 1.  This will 

effectively hide the imprints, but allow you to show the totals at the bottom of the 

chart. 

8. Roll Next Contract – Added an option to roll instrument settings to the next contract.  

This includes the historical instrument and options under the Advanced tab (see 

Instrument Dialog). 

9. Break Even Offset – Added an optional offset (in ticks) to the Break Even button (when 

customizing from the Trade or DOM panel). 

Version 6 Beta 3C 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Custom Order Actions – A custom order can be defined and assigned a keyboard 

shortcut (Professional Edition and above).  This option is available under the General 

Preferences Dialog (Configure -> Preferences from the Console menu bar).  Click on 

“General” then on “Keyboard” then on “Custom Orders” 

2. Quantity Shortcuts – Keyboard shortcuts can be assigned to preset quantities (see Order 

Presets dialog from the Edit Instrument Dialog).  By default, the number keys 1-9 will 

set the quantity to the preset quantity for the instrument in numerical order.  Shortcuts 

can be modified from the Keyboard tab in the General Preferences Dialog (Configure -> 

Preferences from the Console menu bar) click on “General” then on “Keyboard” 

3. Dock Shortcuts – The following keyboard shortcut options have been added for 

navigating pages, stations and tabs in the docking framework (unassigned by default, see 

Preferences Dialog -> “General” -> “Keyboard”): 

a. Next/Previous Page – Sets the active page to the next/previous page. 

b. Next/Previous Station –When a station is maximized these actions will move to 

the next / previous dock station (same as the left/right arrow icons in the dock tool 

bar) 

c. Next/Previous Tab – Sets the active tab on the active station to the next/previous 

tab. 

4. Delete Expired Instruments – Expired instruments (futures contracts and options) can 

be removed from the workspace in the Manage Instruments Dialog (Configure -> 



Instruments in the Console menu bar).  See: Delete Expired button at the bottom of the 

dialog. 

5. PL Price Movement – Options are now available to display the P/L as a price movement 

(instead of a dollar amount): 

a. Trade/DOM Panel – (Pro Edition and above) an additional widget has been 

added “P/L Price Label” to display the Profit/Loss as a price movement. 

b. DOM PL Price Column – This column has been added to show the P/L as a 

price movement. 

6. TPO Study – Added a Font/Font Color option for Letters displayed in the ETH session 

(see Display tab –> Letters ETH) 

7. Volume Imprint –  

a. Added option to toggle display of totals in the summary profile (see Summary 

Profile tab -> Show Totals) 

b. Font Colors – Added options to change the color for labels in the Volume 

Profile, Bid/Ask, Ladder, Volume, Delta and totals 

8. Horizontal Line Tool – Added a mouse tool for creating a horizontal line.  See tools 

drop down (hand cursor by default). 

9. Line Graph Label – Added the symbol to the price graph when displayed as a line 

graph. 

10. Visibility Options – Added the following visibility options to the Visibility tab (see 

Component Properties Dialog): 

a. Visible On Current Bar Size Or Higher – Sets the visibility to be GTE current 

bar size 

b. Visible On Current Bar Size Or Lower – Sets the visibility to be LTE current 

bar size. 

11. Reverse Button – The functionality of this button has been changed to cancel all open 

orders (for the instrument/account) before reversing the position. 

Version 6 Beta 3B 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 3A 

Version 6 Beta 3 contains many new features.  For details see the What’s New In Version 6 

Beta 3 Guide. 

 

List of new Features: 

1. Exit Strategies 

2. Custom Trade Panel 

3. Custom DOM Panel 

4. Analysis Packs 

5. Elliott Wave Markers 

6. Roll Futures Contracts 

7. Much more, see Beta 3 Guide 

https://www.motivewave.com/guides/Whats_New_Version_6_Beta3.pdf
https://www.motivewave.com/guides/Whats_New_Version_6_Beta3.pdf


Version 6 Beta 2E 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 2D 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 2C 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 2B 

This version of MotiveWave includes numerous bug fixes and the following enhancements: 

1. Object Viewer – Components can be locked directly in the Object Viewer (View -> 

Object Viewer from the top menu bar) 

 

Version 6 Beta 2A 

Version 6 Beta 2 contains many new features.  For details see the What’s New In Version 6 

Beta 2 Guide. 

 

List of new Features: 

1. Elliott Wave Custom Ratios 

2. Market By Order 

3. DOM Enhancements 

4. Rithmic Enhancements 

5. TPO Split/Merge 

6. Volume Imprint Enhancements 

7. DOM History Enhancements 

8. Bid Trades Study 

9. OHLC Study 

10. Volume Profile Study Enhancements 

11. Time & Sales Enhancements 

12. SDK Enhancements 

Version 6 Beta 1H 

This version of MotiveWave includes numerous bug fixes and the following enhancements: 

1. Rithmic – Updated to the latest API release 10.6.0.0 

https://www.motivewave.com/guides/Whats_New_Version_6_Beta2.pdf
https://www.motivewave.com/guides/Whats_New_Version_6_Beta2.pdf


Version 6 Beta 1G 

This version of MotiveWave includes numerous bug fixes and the following enhancements: 

1. Rithmic DOM Levels – Support for all Depth of Market levels returned from Rithmic 

API (20+ bid/ask levels) 

2. Volume Imprint/TPO Study – Some significant performance enhancements have been 

added to this update for these studies. 

3. Java 12 – Updated to the latest version of Java and JavaFX 

Version 6 Beta 1F 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 1E 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 1D 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 1C 

This version of MotiveWave includes numerous bug fixes and the following enhancements: 

1. DOM Location – This option allows you to display the DOM panel on the left or right 

side of the chart. See DOM Panel -> Preferences -> General Panel. 

2. Time and Sales Location – This option allows you to display the Time and Sale panel 

on the left or right side of the chart. See TS Panel -> Preferences. 

 

Version 6 Beta 1B 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 1A 

Version 6 contains many new features.  For details see the What’s New In Beta 6 Guide. 

 

Please Note: This is a beta version of MotiveWave™ and may contain more issues that a regular 

release.  Please report any issues to support@motivewave.com. 

 

List of new Features: 

1. Cloud Workspaces 

2. Custom Watch List Columns 

https://www.motivewave.com/guides/Whats_New_Version_6_Beta1.pdf
mailto:support@motivewave.com


3. Gauges 

4. Advanced DOM  

5. Auto Backup 

6. Log File Trimming 

7. Watch List Flags and Filtering 

8. New Components/Tools 

9. Component Templates 

10. Continuous Contracts 

11. Alert Colors 

12. CryptoCompare API – Added support for API Key 

13. Replay Mode in Trade Edition 
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